Artisan™ 700 Series

Basics Guide
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson is a registered trademark, Epson Exceed Your Vision is a registered logomark, and Supplies Central is a service mark of Seiko Epson Corporation.

Artisan is a trademark and Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2008 Epson America, Inc. 7/08
Contents

Using the Control Panel ........................................... 5

Loading Paper ....................................................... 7
Using Special Papers ................................................. 10

Placing Originals for Copying or Scanning ......................... 12

Copying a Document or Photo .................................... 13
Copying a Document .................................................. 13
Restoring, Cropping, or Copying Photos .............................. 14

Printing From Your Camera’s Memory Card ......................... 17
Inserting Your Camera’s Memory Card ................................ 17
Inserting a USB Drive ................................................. 19
Selecting and Printing Photos ....................................... 20
Printing Layout Sheets ............................................... 22
Printing From a Camera .............................................. 24

Printing Special Projects ........................................... 26
Printing Lined Paper and Graph Paper .............................. 26
Printing Personal Notepaper ......................................... 27
Printing CDs and DVDs .............................................. 28

Printing From Your Computer ..................................... 33
Printing in Windows .................................................. 33
Printing With a Macintosh ............................................ 35
Selecting the Correct Paper Type ................................... 39
Two-sided Printing .................................................... 40

Scanning a Document or Photo .................................... 43
Basic Scanning .......................................................... 43
Using the Control Panel

The control panel is adjustable. To raise it, lift it as shown below. To lower it, press the Unlock button and push the control panel down.

Caution:
To avoid damaging the Artisan 700 Series, always press the Unlock button to lower the control panel. Don’t try to push it down.

To save energy, the LCD screen goes dark after 13 minutes of inactivity. Press any button (except the On button) to wake it up.

To switch the display screen from displaying one photo at a time to 9 photos at a time, press the Display/Crop button 3 times when viewing your photos.

The blue status light at the bottom of the panel flashes when the Artisan 700 Series is operating or performing routine maintenance.

Note:
If the blue status light flashes rapidly, check the control panel for error messages.
You may see the following icons on the screen:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon01]</td>
<td>The Artisan 700 Series is connected to a wired network</td>
</tr>
<tr>
<td>![icon02]</td>
<td>The Artisan 700 Series is connected to a wireless network</td>
</tr>
<tr>
<td>![icon03]</td>
<td>The current photo is cropped</td>
</tr>
<tr>
<td>![icon04]</td>
<td>The Fix Red-Eye setting is on for the current photo or all photos</td>
</tr>
</tbody>
</table>
Loading Paper

Your Artisan 700 Series has two paper trays. The main tray is for letter-size, legal-size, A4, or 8 × 10 inch paper. You can load up to 120 sheets of letter-size or A4 plain paper in the main tray. When extended, the tray can hold up to 50 legal-size sheets.

The photo tray is for 4 × 6 or 5 × 7-inch paper. You can load up to 20 sheets of 4 × 6 and 20 sheets of 5 × 7-inch paper.

1. Pull out the paper cassette. Then slide back the photo tray and lift it up.

2. Squeeze the edge guides and slide them out. Then insert paper with the glossy or printable side face-down.

Note:
Load letterhead or pre-printed paper face-down, with the top edge facing the back of the paper cassette. To load legal-size paper, squeeze the lever and extend the tray.
3. Slide the left edge guide against the paper.

4. Adjust the other edge guide to your paper size.

5. Lower the photo tray.
6. To load paper in the photo tray, squeeze the edge guides and slide them out. Then insert photo paper with the glossy or printable side face-down.

7. Slide the left edge guide against the paper. Then adjust the other edge guide to your paper size.

**Note:**
Make sure the paper fits under the edge guide.

8. Keep the cassette flat as you insert it.
9. Extend the output tray and flip up the stopper.

For details on paper and instructions on loading envelopes and legal-size sheets, see the on-screen Epson Information Center.

### Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central℠ at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td>Paper name</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------</td>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041808, S041727</td>
<td>40, 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S042183, S041667</td>
<td>25, 50</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S042181, S042174</td>
<td>60, 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S042182, S042175</td>
<td>25, 50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Borderless 4 × 6 inches</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041405</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Borderless 8 × 10 inches</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041257, S042180</td>
<td>50, 100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 × 11.7 inches)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Placing Originals for Copying or Scanning

You can place one or two photos or a document up to letter-size (or A4) on the scanner glass to make color or black and white copies.

1. Open the document cover and place your original face-down on the scanner glass, with the top against the back left corner.

   If you’re scanning 3 × 5- or 4 × 6-inch photos, you can place up to two at a time on the scanner glass. Place them at least 1/4 inch (5 mm) apart.

2. Close the cover gently so you don’t move the original(s).

   **Note:**
   If the edges of your document or photo are cut off, move the document or photo 1/4 inch (5 mm) away from the corner of the scanner glass.
Copying a Document or Photo

Once you’ve placed your originals on the scanner glass, you can make color or black and white copies. See:

- “Copying a Document” below
- “Restoring, Cropping, or Copying Photos” on page 14

### Copying a Document

1. Place your original for copying (see page 12).
3. Press the Home button until Copy is selected.
4. Press OK.
5. Press + or – to select the number of copies you want.
6. Press ▲ or ▼ to select Color or B&W (black and white) copies.
7. Press ◄ or ▶ to adjust the density (make the copies lighter or darker) if necessary.
8. To change copy settings, press ≈ Menu, then OK to select Paper and Copy Settings. The Layout setting should be With Border and the Paper Size should be Letter.
   - To adjust the copy size, press ▼ to select Reduce/Enlarge, press ►, then press ▲ or ▼ to choose Actual (and select a percentage using + or –), Auto Fit Page (to automatically size the image to fit your paper), or one of the specific sizes listed. Then press OK.
Press ▼ to scroll down to the Paper Type setting and select Plain Paper. Then press OK.

For the Document Type setting, choose Text for plain documents or Text & Image if your document contains photos or graphics. Then press OK.

To change the copy quality, select Quality, press ▶, then press ▲ or ▼ to choose Draft, Standard Quality, or Best. Then press OK.

For more information about copy settings, see your on-screen Epson Information Center.

9. After you finish selecting your settings, press OK.


Restoring, Cropping, or Copying Photos

You can copy one or two photos onto 4 × 6-inch, 5 × 7-inch, 8 × 10-inch, or letter-size photo paper for instant photo reprints. You can also restore colors in faded photos, print with or without borders, convert photos to black and white, and crop your photos.

1. Place one or two photos on the scanner glass. Place them at least 1/4 inch (5 mm) apart.

2. Load 4 × 6-inch or 5 × 7-inch paper in the photo tray or 8 × 10-inch or letter-size Epson photo paper in the main tray. Load it printable side down.

3. Press the Home button until Copy is selected, then press OK. You see this screen.

4. Press ☁ Menu, press ◄ or ► to select Copy/Restore Photos, then press OK.
5. To restore colors in faded photos as you copy, press ▼ to select On. (If your photos are not faded, do not turn on Color Restoration; press OK to select Off.) Then press OK.

6. When you see this screen, press OK to prescan your photos.

7. When you see a message asking you to select the number of copies, press OK.

8. If you placed two photos on the scanner glass, press ◀ or ▶ to view the second one and select the number of copies.

9. To print more than 1 copy, press + or – to select the number (up to 99). If you are copying 2 photos, do this for the other photo as well.

10. If you want to crop one of your photos and enlarge the resulting image area to fit onto your paper, press Display/Crop.
   - To resize the image area, press + or –.
   - To move the image area, use the arrow buttons.
   - To check the zoomed image, press OK.

When you finish cropping your photo, press OK.

11. Press OK again to continue.

12. To change any of the settings displayed on the screen, press ™ Menu and then OK to select Paper and Copy Settings.
   - To change the paper size, select Paper Size and choose the size of paper you loaded. Press OK. (Paper Size options depend on the Paper Type setting you choose.)
To change the paper type, select **Paper Type**, press ▶, then press ▲ or ▼ to choose the setting for the paper you loaded:

<table>
<thead>
<tr>
<th>For this paper type</th>
<th>Choose this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
</tbody>
</table>

To change the print layout, select **Borderless**, then press ▶. Press ▲ or ▼ to choose **On** to expand the image all the way to the edge of the paper (slight cropping may occur) or **Off** to leave a small margin around the image. Then press **OK**.

To adjust the amount of image expansion when printing borderless photos, select **Expansion**, press ▶, then press ▲ or ▼ to choose **Standard**, **Medium**, or **Minimum**. Then press **OK**. (Your printed photos may have white borders if you use the **Medium** or **Minimum** setting.)

To automatically adjust brightness, contrast, and saturation to best effect, select **Fix Photo**, then press ▶. Press ▲ or ▼ to choose **On**.

If you want to create a black-and-white copy of a color photo, select **Filter**, press ▶, then press ▲ or ▼ and choose **B&W**. Then press **OK**.

13. After you finish selecting your settings, press **OK**.

14. When you're ready to copy, press ◇ **Start**. To cancel copying, press ◇ **Stop/Clear Settings**.

**Note:**
When you scan with your computer, you can use additional options to transform faded, dusty, or badly exposed photos into ones with true-to-life color and sharpness. See the on-screen **Epson Information Center** for details.
Printing From Your Camera’s Memory Card

The Artisan 700 Series lets you print photos from your digital camera’s memory card, or by connecting your camera directly and using its DPOF™ settings. You can also print photos stored on a USB drive. See these sections:

■ “Inserting Your Camera’s Memory Card” below
■ “Inserting a USB Drive” on page 19
■ “Selecting and Printing Photos” on page 20
■ “Printing Layout Sheets” on page 22
■ “Printing From a Camera” on page 24

Inserting Your Camera’s Memory Card

1. Insert the card into the correct slot, as shown. Insert just one card at a time.

Upper slot:  SD™, SDHC™
            miniSD™*, miniSDHC*
            microSD*, microSDHC*
            MultiMediaCard™
            MMCplus, MMCmobile, MMCmicro*
            Memory Stick™
            Memory Stick Duo™*
            Memory Stick Micro™*
            Memory Stick PRO™
            Memory Stick PRO Duo™*
            Memory Stick PRO-HG Duo*
            MagicGate™ Memory Stick
            MagicGate Memory Stick Duo™*
            xD-Picture Card™
            xD-Picture Card Types H, M, M+

Lower slot:  CompactFlash®
            Microdrive™
            * Adapter required
Make sure the image files on your card meet these requirements:

<table>
<thead>
<tr>
<th>File format</th>
<th>JPEG with the Exif version 2.21 standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image size</td>
<td>80 × 80 pixels to 9200 × 9200 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 9990 (If there are more than 999 photos on the card, you can select a group of photos to display. See your on-screen Epson Information Center.)</td>
</tr>
</tbody>
</table>

2. After you insert the card, the memory card access light flashes, then stays on.

3. See page 20 to select and print your photos.

**Removing Your Card**

After you finish printing your photos, follow these steps to remove the card:

1. Make sure the memory card access light is not flashing.

   **Caution:**
   Do not remove the card or turn off the Artisan 700 Series while the memory card access light is flashing; you may lose data on the card.

2. If the Artisan 700 Series is connected to your computer, do one of the following before removing the memory card or turning it off:
   - **Windows®:** Click the or icon on the taskbar and select Safely remove USB Mass Storage Device.
   - **Macintosh®:** Drag the removable disk icon from your desktop into the trash.

3. Pull the card straight out of its slot.
Inserting a USB Drive

You can print from an external storage device connected to the Artisan 700 Series, such as a USB flash drive, external hard drive, or CD burner.

**Note:**
Epson cannot guarantee the compatibility of any drives. You may not be able to print photos from the storage device if they were saved to the device using a product other than the Artisan 700 Series.

1. Remove any inserted memory card from the Artisan 700 Series.
2. Insert your USB flash drive or the USB cable for your external drive into the USB connector on the front of your Artisan 700 Series.
3. Insert storage media (such as a CD) into your drive, if necessary.
4. If there are folders on your storage media, select the folder you want and press **OK**.
5. See the next section to select and print your photos.

**Note:**
Before removing your USB drive, make sure its access light is not flashing.
Selecting and Printing Photos

1. Load Epson photo paper. See page 10 for a list.

2. Press the Home button until Photos is selected, then press OK.

3. Select View and Print Photos and press OK.

4. Press ◄ or ► to move through your photos and display one you want to print.
   
   Tip:
   View Auto Correct: Off appears at the top of the display screen. Press View Auto Correct to see how the image will look when Fix Photo is turned on (see page 21). Press View Auto Correct again to return to the original view.

5. To print more than one copy, press + or – to select the number of copies you want of that photo.

6. If you want to crop the photo and enlarge the resulting image area to fit onto your paper, press Display/Crop.
   
   ■ To resize the image area, press + or –.
   ■ To move the image area, use the arrow buttons.
   ■ To rotate the image area, press ⇒ Menu.
   ■ To check the zoomed image, press OK.

   When you finish cropping your photo, press OK.

7. Press ◄ or ► to view other photos, select the number of copies, and crop, if desired.

8. When you're done selecting photos, press OK. You see the Print Preview screen:
9. To change any of the print settings displayed on the screen, press \texttt{Menu}, select \textbf{Print Settings}, press \texttt{OK}, and select your settings. For a list of Epson papers and the corresponding Paper Type settings, see page 22. When you're done selecting settings, press \texttt{OK}.

10. To change any of the photo adjustments displayed on the screen or fix red-eye, press \texttt{Menu}. Select \textbf{Photo Adjustments}, press \texttt{OK}, and select your settings.

\textbf{Note:}
For the best quality printing, leave Fix Photo (in the Photo Adjustments menu) turned on. This automatically adjusts brightness, contrast, and saturation to best effect.

Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face (without sunglasses). If your photo includes a face with an intentional color cast, such as a bronze statue, you may want to turn off this setting to retain the special color effects.

11. When you're ready to print, press \texttt{Start}.

To cancel printing, press \texttt{Stop/Clear Settings}.

\textbf{Note:}
To switch the display screen from displaying one photo at a time to 9 photos at a time, press the \texttt{Display/Crop} button 3 times when viewing your photos.
Printing Layout Sheets

You can print the same photo or multiple photos on a single sheet of paper using the Artisan 700 Series templates.

1. Press the Home button until Photos is selected.

2. Press or and select Photo Layout Sheet. You see this screen:

3. Press or and select one of the layout settings shown on the screen.

   **Note:**
   As indicated by the icons, some of the layouts let you place different photos on the same sheet.

4. Select Paper Size, then choose the size of paper you loaded.

   **Note:**
   Paper Size options depend on the Paper Type setting you choose.

5. Select Paper Type, then choose the correct setting for the type of paper you loaded:

<table>
<thead>
<tr>
<th>For this paper type</th>
<th>Choose this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
</tbody>
</table>
6. When you’re done selecting settings, press OK. You see this screen:

7. Select Automatic layout to let the Artisan 700 Series place images in the layout sheets for you, or select Place photos manually to arrange the images yourself. (This option may not be available, depending on the paper settings you choose.)

8. When you see this screen, press OK.

9. Follow the instructions on the screen to add photos to the layout sheet.

   **Note:**
   If you don’t select enough photos to fill the layout you selected, you will see a warning message, and the layout will have some blank spaces.

10. To print more than 1 copy of the sheet, press + or – to select the number (up to 99).

11. Press **Menu** to change any of the settings displayed on the screen. Select one of the following options:
Printing From Your Camera’s Memory Card

- **Print Settings** to change the paper type and size, or other print settings
- **Photo Adjustments** to turn on red-eye reduction or other features

When you’re done selecting settings, press **OK**.

12. When you’re ready to print, press **Start**.

To cancel printing, press **Stop/Clear Settings**.

---

**Printing From a Camera**

If you have a digital camera that supports PictBridge™ printing, you can connect it to the Artisan 700 Series and print your photos directly from the camera. Check your camera manual to see if it is compatible.

Your photos must be in JPEG format and sized from 80 x 80 to 9200 x 9200 pixels.

**Note:**
Epson cannot guarantee the compatibility of any cameras. Some combinations of paper types, sizes, and layouts may not be supported, depending on your camera and the Artisan 700 Series settings.

1. Remove any inserted memory card from the Artisan 700 Series.

2. Connect the USB cable that came with your camera to the USB connector on the front of your Artisan 700 Series.

3. Turn on your camera. You see a connection message on the Artisan 700 Series display screen.

4. Load Epson photo paper (see page 7).

5. Press the **Home** button until **Setup** is selected, then press **OK**.
6. Press ◀ or ▶ and select PictBridge Setup, then press OK. You see this screen:

7. Select the following settings (see the on-screen Epson Information Center for details):

- Print Settings to select the paper type and size, or other print settings.
- Photo Adjustments to turn on red-eye reduction or other features.

When you’re done selecting settings, press OK.

8. Follow the instructions that came with your camera to select and print your photos.
Printing Special Projects

You can use your Artisan 700 Series to make ruled paper and graph paper for homework projects, and even notepaper personalized with your favorite photos. You can also print customized labels directly on to ink jet-printable CDs and DVDs.

See these sections:

■ “Printing Lined Paper and Graph Paper” on page 26
■ “Printing Personal Notepaper” on page 27
■ “Printing CDs and DVDs” on page 28

Printing Lined Paper and Graph Paper

You can have the Artisan 700 Series print lined paper or graph paper whenever you need it.

1. Load plain letter- or A4-size paper.
2. Press the Home button.
3. Press ← or → to select Print Ruled Papers, then press OK. You see this screen:

4. Press ← or → and select Wide Rule, Narrow Rule, or Graph Paper for your paper size. Then press OK.
5. When you see a message asking you to load paper, press OK.
6. To print more than 1 sheet, press + or − to select the number (up to 99).
7. When you're ready to print, press ◐ Start. To cancel printing, press ◐ Stop/ Clear Settings.

**Printing Personal Notepaper**

You can print lined or unlined notepaper, personalized with a photo in the background.

1. Load plain letter- or A4-size paper.
2. Insert a memory card (see page 17) or USB drive (see page 19).
3. Press the Home button.
4. Press ◄ or ► to select Print Ruled Papers, then press OK.
5. Press ◄ or ► and select one of the Stationery settings (with or without lines) for your paper size. Then press OK.

6. When you see this screen, press OK.
You see a preview of how your stationery will look with a photo in the background.

7. To rotate the layout, press ▼.
8. Press ▲ or ▼ to move through your photos and display the one you want to use for your notepaper.
9. Press OK.
10. When you see a message asking you to load paper, press OK.
11. To print more than 1 sheet, press + or – to select the number (up to 99).
12. When you’re ready to print, press ◇ Start. To cancel printing, press ◇ Stop/Clear Settings.

Printing CDs and DVDs

You can use your Artisan 700 Series to print a design right onto ink jet-printable CDs and DVDs. Follow these steps to transfer one or more photos from a memory card or USB drive onto your CD/DVD.

Note:
You can also copy a CD/DVD design, print a jewel case insert, and create your own designs using the Epson Print CD software that came with your Artisan 700 Series. For more information, see the on-screen Epson Information Center.

1. To prevent errors, first burn files, music, or video onto your CD/DVD before printing on it.
2. Insert your memory card (see page 17) or USB drive (see page 19).
3. Press the Home button until Photos is selected, then press OK.
4. Press ◄ or ► to select Print on CD/DVD, then press OK. You see this screen:

5. Select 1-up, 4-up, or CD/DVD Variety (10-up) to indicate the number of photos in the layout, then press OK.

6. Select Automatic layout or Place photos manually, if necessary.

7. Press OK.

8. Press OK again.

9. Press ◄ or ► to move through your photos and display one you want to print. Press the + button to select the number of copies you want of that photo. For multiple photo layouts, repeat for each photo you want to include. You can also press Display/Crop and crop your photos (see page 15 for instructions).

10. Press OK when done selecting photos. You see this screen:
11. If necessary, adjust the inner and outer diameter of your CD as shown on the screen, then press OK.

12. If desired, select Test Print on Letter/A4 paper and follow the on-screen instructions to print a test on plain paper.

13. If your test is satisfactory, select Print on a CD/DVD. The CD/DVD tray extends automatically and you see this screen:

14. Raise the control panel all the way up.
15. Place your disc on the tray with the label side up. Gently press it in place (it does not snap in).

**Caution:**
Do not try to pull the CD/DVD tray out; it extends automatically as far as possible.

16. Press the CD Tray button to position the CD/DVD for printing.

**Caution:**
Do not turn the Artisan 700 Series off with a CD or DVD loaded in it. Always remove the disc first.

17. Press Menu to change any of these settings:

- **Print Settings** to change the print density or other print settings
- **Photo Adjustments** to turn on red-eye reduction or other features

When you're done selecting settings, press OK.

18. When you see this screen, press Start to begin printing.

After your CD/DVD is printed, the tray extends from the Artisan 700 Series.
19. Remove your disc.

20. Press the \textit{CD Tray} button to put away the CD/DVD tray.
21. Press the \textit{Unlock} button and push the control panel down.

\textit{Note:}
After printing, handle your CD/DVD carefully. You may need to wait up to 24 hours for the ink to dry fully before inserting it in a drive. Keep printed discs away from moisture and direct sunlight.
Printing From Your Computer

This section describes the basic steps for printing a photo or document stored on your Windows or Macintosh computer. For instructions on two-sided printing, see page 40. For additional printing instructions, see the on-screen Epson Information Center.

Before you start, make sure you’ve installed your printer software and connected the Artisan 700 Series to your computer as described on the Start Here sheet.

Tip:
It’s a good idea to check for updates to your Artisan 700 Series software. See page 51 for instructions.

You can also create personalized photo greeting cards, calendars, and more using the ArcSoft Print Creations™ software included with your Artisan 700 Series. To get started, double-click the Print Creations icon on your desktop (Windows) or in your Applications folder (Macintosh).

Printing in Windows

1. Open a photo or document in an application.
2. Open the File menu and select Print. You see a window like this one:
3. Select EPSON Artisan 700 Series, then click the Preferences or Properties button.

   **Note:**
   If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen.

4. On the Main tab, select the basic print settings. Make sure you choose the correct paper Type setting for the paper you are using (see page 39).

   - Select the type of document you’re printing (choose Photo or Best Photo for photos)
   - Select your paper Type
   - Select your paper Size
   - Click here for borderless photos
   - Select your document or photo Orientation

   **Note:**
   For quick access to the most common settings, click the Shortcuts tab and select one of the presets. You can create your own presets by clicking the Save Settings button on the Advanced tab. For details, see your on-screen Epson Information Center.

5. To improve the color, contrast, and sharpness of photos, select Fix Photo.

6. To reduce or remove red-eye effects in photos, select Fix Red-Eye.

7. If you want to reduce or enlarge your printout, or print double-sided, click the Page Layout tab and select settings as necessary.

8. For more printing options, click the Advanced tab.

   **Note:**
   For more information about print settings, click Help or see your on-screen Epson Information Center.

9. Click OK to save your settings.

34 Printing From Your Computer
10. Click OK or Print to start printing. This window appears and shows the progress of your print job.

Printing With a Macintosh

See the section below for your Mac OS® operating system.

**Mac OS X 10.5**

1. Open a photo or document in an application.
2. Open the File menu and select Print.
3. Select EPSON Artisan 700 as the Printer setting.
4. Click ▼ to expand the Print window, if necessary.
5. Select the basic page setup options. For borderless photos, choose a Paper Size setting with a Borderless option.

Note:
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing. Or check for it in the settings for your application at the bottom of this window. (If you’re printing from Preview, you see the settings shown below.)

6. Choose Print Settings from the pop-up menu, then select the following print settings:

7. Choose any other printing options you may need from the pop-up menu. See the on-screen Epson Information Center for details.
Note:
To reduce or remove red-eye effects in photos, choose Extension Settings from the pop-up menu and select Fix Red-Eye.

8. Click Print.

9. To monitor your print job, click the icon in the dock. Select your print job, then select an option to cancel, pause, or resume printing, if necessary.

Mac OS X 10.3 and 10.4

1. Open a photo or document in an application.

2. Select Page Setup from the File menu. Select the following settings:

   - Select Artisan 700
   - Select your Paper Size
   - Select your document or image orientation

   For borderless photos, choose a Borderless option in the Paper Size list for your paper size.
3. Click OK to close the Page Setup window.

4. Select Print from the File menu. You see a window like this one:

   ![Print window]

5. Choose Print Settings from the pop-up menu, and select the following print settings, as necessary:

   ![Print settings]

   **Note:**
   In certain programs, you may need to select Advanced before you can select Print Settings. For more information about printer settings, click the ? button.

6. Click the Advanced button to change additional settings.

   **Note:**
   For more information on advanced settings click ?.

7. Choose any other printing options you may need from the pop-up menu. See the on-screen Epson Information Center for details.
8. Click Print.

9. To monitor your print job, click the icon in the dock (or click the Print Center icon and double-click Artisan 700 on the next screen).

Selecting the Correct Paper Type

Select the correct Type (see page 34) or Media Type (see page 38) setting in your printer software. This tells the Artisan 700 Series what kind of paper you’re using, so the ink coverage can be adjusted accordingly.

<table>
<thead>
<tr>
<th>For this paper/media</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-gloss</td>
</tr>
</tbody>
</table>
Two-sided Printing

If you have the optional auto duplexer, you can print on both sides of the page automatically.

With Windows, you can configure the printer software and perform two-sided printing even if you don’t have the auto duplexer.

Note:
For detailed instructions on two-sided printing and installing or removing the auto duplexer, see the on-screen *Epson Information Center*.
Windows

Follow the Windows printing instructions beginning on page 33, but complete the additional steps below before you start printing.

1. Click the Page Layout tab in the printer software.

2. Select Auto as your 2-sided printing setting if you’ve installed the auto duplexer, or Manual if you don’t have the auto duplexer.

   **Note:**
   When you use the Manual setting, the printer software will prompt you to reload the printed pages as necessary.

3. If you’re printing on plain paper and you notice that ink smears or bleeds through the page, click Adjust Print Density to reduce the print density and increase the ink drying time.
**Mac OS X**

Follow the Macintosh printing instructions beginning on page 35 (Mac OS X 10.5) or page 37 (Mac OS X 10.3 and 10.4), but complete the additional steps below before you start printing.

1. Select **Auto Duplex Printing Settings** from the pop-up menu.

2. Select **Auto Duplex Printing**.

   **Note:**
   If you see a message indicating that the auto duplexer is not installed, open EPSON Printer Utility3 (in the Applications folder on your hard drive), select Artisan 700 Series, click OK, click the **Printer and Option Information** button, and click OK again. Then close and reopen the print window.

3. If you’re printing on plain paper and you notice that ink smears or bleeds through the page, you may need to reduce the print density and increase the ink drying time.
Scanning a Document or Photo

You can use your Artisan 700 Series to scan original documents and photos and save them as digital files on your computer.

You can also turn scanned documents into editable/searchable text using ABBYY FineReader® Sprint Plus (OCR software) included with your Artisan 700 Series. For more information, see the on-screen Epson Information Center.

The Epson Scan software provides three scanning modes:

- **Full Auto Mode** scans quickly and easily using automatic settings.
- **Home Mode** previews your image and provides preset options for scanning.
- **Professional Mode** previews your image and provides a full array of tools.

**Note:**
For detailed scanning instructions, see the on-screen Epson Information Center.

Basic Scanning

You can scan from any TWAIN-compliant application using Epson Scan. Or you can start Epson Scan directly from your computer and save your image to a file.

1. Open the document cover and place your original face-down on the scanner glass, in the back left corner, as shown on page 12.
2. Close the cover gently so you don’t move the original.
3. Do one of the following to start Epson Scan:
   - **Windows:**
     Double-click the EPSON Scan icon on your desktop.
   - **Macintosh:**
     Double-click EPSON Scan in the Applications folder.
   - If you are scanning from an application, start your application. Then open the File menu, choose Import or Acquire, and select your Artisan 700 Series (if necessary).
You see the Epson Scan standby window.

4. If the Mode setting in the upper right corner is set to Full Auto Mode, click the Scan button.

   **Note:**
   If you want to automatically restore a color photo as you scan, click the Customize button, then check the Color Restoration box.

   - If you are scanning from Epson Scan directly, the image is scanned and you see its icon in Windows Explorer or Macintosh Finder.
   - If you are scanning from an application, the scanned image opens in your application window.
   - If you are in Home or Professional mode, you see the Epson Scan settings window.
Maintaining Your Artisan 700 Series

Follow the steps here to check and clean the print head, and replace ink cartridges. To align the print head, if necessary, see the on-screen Epson Information Center.

Checking the Print Head Nozzles

If your printouts have gaps or lines across them, the print head nozzles may be clogged. Follow these steps to check the print head nozzles:

1. Load letter-size plain paper in the main tray.
2. Press the Home button.
3. Press ◄ or ► to select Setup, then press OK.
4. Press ◄ or ► to select Maintenance, then press OK.
5. Select Nozzle Check, then press OK. You see this screen:
6. Press ◄ Start.
7. Check the nozzle check pattern that prints to see if there are gaps in the lines:

![Nozzle check pattern]

8. If there are no gaps, the print head is clean. Select Finish Nozzle Check, then press OK.
Maintaining Your Artisan 700 Series

If there are gaps or the pattern is faint, select Head Cleaning, then press OK. Then press ◁ Start to clean the print head.

Cleaning the Print Head

If print quality has declined and the nozzle check indicates clogged nozzles, you can clean the print head. Print head cleaning uses ink, so clean it only if necessary.

**Note:**
You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first (see page 49).

1. Load letter-size plain paper in the main tray.
2. Press the Home button.
3. Press ◁ or ▶ to select Setup, then press OK.
4. Press ◁ or ▶ to select Maintenance, then press OK.
5. Select Head Cleaning, then press OK.
6. Press ◁ Start.
   Cleaning takes about 2 minutes. When it’s finished, you see a message on the display screen.
   **Caution:**
   Never turn off the printer during a cleaning cycle or you may damage it.
7. Select Nozzle Check. Then press ◁ Start to run a nozzle check and confirm that the print head is clean.
8. Select Finish Cleaning and press OK when you’re done.

**Note:**
If you don’t see any improvement after cleaning the print head four times, leave your Artisan 700 Series turned on and wait at least six hours to let any dried ink soften. Then try printing a nozzle check and cleaning again if necessary. If you do not use your Artisan 700 Series often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking the Ink Cartridge Status

Your Artisan 700 Series will let you know when an ink cartridge is low or expended by displaying a message on its screen or on your computer. You cannot print or copy when an ink cartridge is expended even if the other cartridges are not expended. Replace any expended cartridges before printing or copying. You can still scan and view photos on the display screen.

To check ink cartridge status from the display screen anytime, follow these steps:

1. Press the Home button until Setup is selected. Then press OK.

2. Press ↓ or ↑ to select Ink Levels, then press OK.
   You see a screen like this:
   A cartridge marked with △ is getting low on ink. See page 49 to replace the cartridge, if necessary.

3. Press OK to exit.

A window may appear on your computer screen when you try to print when ink is low. This window can optionally display ink offers and other updates retrieved from an Epson website. On a Windows computer or Mac OS X 10.5 that is connected to the Internet, you may see a screen asking if you want to receive these Epson offers the first time you print. Click Accept or Decline.

Note:
To disable checking for ink offers or updates from Epson, see the instructions in your on-screen Epson Information Center.
Purchasing Epson Ink Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central™ at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Color</th>
<th>Standard Capacity</th>
<th>High Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Magenta</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Yellow</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Cyan</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Light Magenta</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Light Cyan</td>
<td>99</td>
<td>98</td>
</tr>
</tbody>
</table>

Note:
The 98 (High Capacity Black (and all 99 Standard Capacity) ink cartridges are available online and from Epson authorized resellers. The 98 (High Capacity) color cartridges are available only online. Visit Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales).

We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on. The printer ships with full cartridges and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package.

Store ink cartridges in a cool, dark place. If cartridges were exposed to cold temperatures, allow them to warm up to room temperature for at least 3 hours before using them.
Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

**Caution:**
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability. Leave the expended cartridge(s) installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out. If you remove a low or expended cartridge, you cannot reinstall and use it.

1. Turn on the Artisan 700 Series.

   If a cartridge is low or expended, you see a message on the display screen. Note which cartridges need to be replaced and press OK. (You cannot print until you have replaced any expended ink cartridges.)

   If you're replacing a cartridge before it's expended, follow the steps below.

2. Open the scanner.
3. Squeeze the tab on the cartridge and lift it straight up. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

**Warning:**
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.

4. Remove the cartridge from the package. Do not touch the green chip on the side.

5. Remove the yellow tape from the bottom of the cartridge.

**Caution:**
Do not remove any other labels or seals, or ink will leak.

6. Insert the new cartridge into the holder and push it down until it clicks into place.

7. Close the scanner.

**Note:**
If you see a warning message that the cartridge you just replaced is not installed, open the scanner and press down the cartridge securely.
Solving Problems

Check the messages on the display screen to diagnose the cause of most problems. Press the Home button, if necessary, then press ◀ or ▶ to select Problem Solver. Press ▲ or ▼ to see all the help topics.

You can also check the basic troubleshooting suggestions (beginning on page 52) or see the on-screen Epson Information Center for more detailed help.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website for free updates to your Artisan 700 Series software. Open your on-screen Epson Information Center and select Download the Latest Software or visit Epson’s support website at epson.com/support (U.S.) or epson.ca (Canada).

With Windows, you can do one of the following:

■ Right-click the printer icon on your task bar and select Driver Update.

■ Click ☰ or Start, select All Programs or Programs, then EPSON, then EPSON Artisan 700 Series, and then select Driver Update.

■ Click the Maintenance tab in the printer settings window and select Driver Update.
Problems and Solutions

You can often solve problems by checking the messages on the display screen. If the information doesn't help you solve the problem, check the solutions below.

Note:
If the screen is dark, press any button to wake the Artisan 700 Series from sleep mode.

Printing and Copying Problems

- Make sure your paper is loaded printable side down (usually the whiter, brighter, or glossy side). Don't load paper above the edge guides.

- Make sure the type of paper you loaded matches the paper size and paper type settings on the control panel when copying or printing (see page 16), or in your printer software (see page 39).

- Make sure your original is positioned against the back left corner of the scanner glass. If the edges are cropped, move your original away from the edges slightly.

- If you're copying, place the document flat against the scanner glass.

- Clean the scanner glass with a soft, dry, lint-free cloth (paper towels are not recommended), or use a small amount of glass cleaner on a soft cloth, if necessary. Do not spray glass cleaner directly on the glass.

Paper Feeding Problems

If paper jams when printing, check the following:

1. Open the scanner and remove paper as shown, including any torn pieces.

Caution:
To prevent damage, avoid handling parts inside the Artisan 700 Series.
2. Pull back on the tabs to remove the cover inside the Artisan 700 Series. Then remove the paper as shown, including any torn pieces.

3. Reattach the cover and close the scanner.

4. You may also need to check other locations for jammed paper, such as the paper cassette, the back cover or auto duplexer (if installed), and underneath the Artisan 700 Series. See the on-screen Epson Information Center for details.

**Print Quality Problems**

- For the best print quality, use Epson papers (see page 10) and genuine Epson ink cartridges (see page 49).

- If you notice light or dark bands across your printouts or they are too faint, run a nozzle check (see page 45) to see if the print head needs cleaning.

- If you notice jagged vertical lines, you may need to align the print head. See the on-screen Epson Information Center for instructions.

- The ink cartridges may be low on ink. Check your cartridge status (see page 47) and replace cartridges, if necessary (see page 49).
Where To Get Help

Epson Technical Support

Internet Support
Visit Epson's support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Artisan 700 Series)
■ Product serial number (located on the label in back and under the scanner)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration and description of the problem

Then call:

■ U.S.: (562) 276-4382, 6 AM – 6 PM, Pacific Time, Monday through Friday
■ Canada: (905) 709-3839, 6 AM – 6 PM, Pacific Time, Monday through Friday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Other Software Technical Support

ArcSoft Print Creations
www.arcsoft.com/support

ABYY FineReader Sprint Plus
Phone: (510) 226-6717
www.abbyusa.com
support@abbyusa.com
Notices

Important Safety Instructions

Before using your all-in-one, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the product.
■ Use only the type of power source indicated on the product label.
■ Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
■ Place the product near a wall outlet where the plug can be easily unplugged.
■ If you won’t be using the product for a long period, unplug the power cord from the electrical outlet.
■ Always turn off the product using the On button, and wait until the On light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
■ Avoid plugging the product into an outlet on the same circuit as a photocopier or air conditioning system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
■ When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.
■ Avoid placing the product in locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the product for sufficient ventilation. Make sure the product is at least 4 inches (10 cm) away from the wall.
■ Do not place the product near a radiator or heating vent or in direct sunlight.
■ Do not block or cover openings in the product case or insert objects through the slots.
- Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
- Do not press too hard on the document table when placing the originals.
- Do not open the scanner section while the product is in use.
- Do not touch the flat white cable inside the product.
- Do not spill liquid on the product.
- Adjust only those controls that are covered by the operating instructions. Except as specifically explained in your documentation, do not attempt to service the product yourself.
- Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance.
- The cords included with this product contain chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling. (This notice is provided in accordance with Proposition 65 in Cal. Health & Safety Code § 25249.5 and following.)

**LCD Screen Safety**

- Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
- If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

**Ink Cartridge Safety Instructions**

- Keep ink cartridges out of the reach of children and do not drink the ink.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water. If you still have discomfort or vision problems, see a doctor immediately.
- Do not put your hand inside the product or touch any cartridges during printing.
- Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.
If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the product. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area. Do not store the cartridge upside down.

---

**Epson America, Inc., Limited Warranty**

**What Is Covered:** Epson America, Inc. (“Epson”) warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for the warranty period, as measured from the date of original purchase. The “warranty period” means two years, if you registered your printer purchase with Epson within 60 days of purchase, and one year otherwise. For residents of California or Quebec, failure to submit the product registration form does not diminish your warranty rights. For warranty service, you must provide proof of the date of original purchase.

This limited warranty statement also covers any Epson-branded duplexer purchased separately for use with the printer. The warranty period for your duplexer is the same as the period for your printer. In this limited warranty statement, the “product” means the printer and the duplexer.

**What Epson Will Do To Correct Problems:** Should your Epson printer prove defective during the warranty period, please call the Epson Connection℠ at (562) 276-4382 (U.S.) or (905) 709-3839 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.
What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.
To find the Epson Customer Care Center nearest you, visit http://www.epson.com/support.

You can also write to:

Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012

Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C391A
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user's authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Index

A

ABBY FineReader software, 43
Accessories, purchasing, 54
ArcSoft Print Creations software, 33
Auto Correction for photos, 20 to 21

B

Buttons, 5

C

Calendars, printing, 33
Camera
  connecting, 24
  printing from, 24 to 25
Cassette, loading paper, 7 to 10
CD
  creating label, 28 to 32
  placing on tray, 30 to 31
  removing from tray, 32
Cleaning
  print head, 46
  scanner glass, 53
Color in photos
  correcting, 20 to 21
  restoring, 15, 44
Control panel, 5
Copying
  documents, 13 to 14
  photos, 14 to 16
  problems, 52
Cropping a photo, 15, 20

D

Displaying multiple photos, 5
Documents
  copying, 13 to 14
  placing on scanner, 12
Duplexer
  printing with, 40 to 42
  purchasing, 54
DVD
  creating label, 28 to 32
  placing on tray, 30 to 31
  removing from tray, 32

E

Epson
  help, 54
  ink offers, 47
  paper settings, 39
  papers, 10 to 11
  warranty, 57 to 59
Epson Print CD software, 28
Epson Scan software, 43 to 44
External storage drive, inserting, 19

F

File format, photos, 18
Fix Photo setting, 20 to 21, 34
Flash drive, inserting, 19

G

Graph paper, printing, 26
H
Help, 51, 54

I
Icons on screen, 6
Ink cartridges
   checking status, 47
   offers from Epson, 47
   purchasing, 48, 54
   replacing, 49 to 50
   safety instructions, 56 to 57

L
Label, CD/DVD, 28 to 32
Layout sheets, printing, 22 to 24
LCD screen
   safety instructions, 56
   using, 5
Light, blue, 5
Lined paper, printing, 26
Lines in printout, fixing, 45

M
Macintosh
   OS X 10.3 and 10.4, 37 to 39
   OS X 10.5, 35 to 37
   printing, 35 to 39
   two-sided printing, 42
Maintenance
   checking ink cartridge status, 47
   checking print head, 45
   cleaning print head, 46
   replacing ink cartridges, 49 to 50
Media Type setting, 39
Memory card
   inserting, 17 to 18
   photo file format, 18
   printing from, 20 to 24
   removing, 18
Notebook paper, printing, 26
Notepaper, personalized, 27 to 28
Nozzle Check, 45
Paper
   Epson, 10 to 11
   jams, 52 to 53
   loading, 7 to 10
   types, 39
Paper type setting, 22, 39
Photo greeting cards, printing, 33
Photos
   adjustments, 21
   Auto Correction, 20 to 21
   copying, 14 to 16
   cropping, 15, 20
   displaying multiple photos, 5
   file format, 18
   layout sheets, 22 to 24
   placing on scanner, 12
   print settings, 21
   printing from memory card, 20 to 24
   restoring color, 15, 44
   selecting and printing, 20 to 25
PictBridge, 24 to 25
Print Creations software, 33
Print head
   checking, 45
   cleaning, 46
Printing
- CD/DVD, 28 to 32
- from a camera, 24 to 25
- from computer, 33 to 42
- layout sheets, 22 to 24
- Macintosh, 35 to 39
- photos, 20 to 25
- problems, 52
- two-sided pages, 40 to 42
- Windows, 33 to 35

Problem Solver, 51

Problems
- copying, 52
- paper jams, 52 to 53
- print quality, 53
- printing, 52

R

Red-eye reduction, 21, 34, 37
Restoring photos, 15
Ruled paper, printing, 26

S

Safety instructions, 55 to 57
Scanning, 43 to 44
Sleep mode, 5
Software
- ABBY FineReader, 43
- ArcSoft Print Creations, 33
- Epson Print CD, 28
- Epson Scan, 43 to 44
- support, 54
- updates, 51
Stationery, personalized, 27 to 28
Status light, 5
Support, Epson, 54
Symbols on screen, 6

T

Technical support, 54
Troubleshooting
- copying problems, 52
- paper jams, 52 to 53
- print quality, 53
- printing problems, 52
- Two-sided printing, 40 to 42

U

Unlock button, 5
USB drive, inserting, 19

W

Warranty, 57 to 59
Windows
- printing from, 33 to 35
- two-sided printing, 41